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About This Manual

Use this Getting Started guide as a resource to using VI Logger, from
installing software and hardware to executing and analyzing data logging
data.

Conventions
The following conventions appear in this manual:

[ ] Square brackets enclose optional items—for example, [response].

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash.

bold Bold text denotes items that you must select or click on in the software,
such as menu items and dialog box options. Bold text also denotes
parameter names, controls, and buttons on the front panel, dialog boxes,
sections of dialog boxes, menu names, and palette names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames and extensions, and code excerpts.

monospace bold Bold text in this font denotes the messages and responses that the computer
automatically prints to the screen. This font also emphasizes lines of code
that are different from the other examples.
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monospace italic Italic text in this font denotes text that is a placeholder for a word or value
that you must supply.

Related Documentation
The following documents contain information that you might find helpful
as you read this manual:

• VI Logger Help, available by selecting Help»VI Logger in LabVIEW

• LabVIEW Help, available by selecting Help»Contents and Index

• Measurement & Automation Explorer Help, available by selecting
Help in MAX

• The getting started or user manuals for the devices you use
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1
Using VI Logger

VI Logger equips you with the necessary software tools to define and
execute a data logging task. With VI Logger, you can view real-time data,
share data, and browse and manage historical data. Using VI Logger in
Measurement & Automation Explorer (MAX), and features such as
triggered acquisition, event detection, and actions and calculated channels,
you can define advanced tasks without any programming. Using LabVIEW
and the VI Logger VIs, you can execute a task, view live data, browse
historical data, and build logging applications using all of the advanced
programming capabilities of LabVIEW.

Overview
VI Logger provides dialog boxes to configure data logging tasks. When the
task runs, acquired data can be displayed in a temporary window with the
task, and logged data is stored internally. See the following figure for an
overview of how VI Logger interacts with other software.
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A VI Logger task can run in a stand-alone mode from MAX or as part of
an application in LabVIEW. A VI Logger task controls data acquisition
(DAQ) and logging. With VI Logger, you can customize start and stop
conditions for acquisition. The VI Logger task also logs data for one or
more channels. After logging data, you can view the data for each time the
task is run. You can view data from each executed task.

Chapter 2, Creating and Running a VI Logger Task, describes how to
create your VI Logger task in MAX. Chapter 3, Controlling Your Task
Programmatically Using LabVIEW, describes how to control a logging
task from LabVIEW.

VI Logger Features
VI Logger helps you log data from your National Instruments DAQ
devices. In order to set up the logging system, you first set up the
measurement system. You can configure the logging system with

• Execute Task
• View Data
• Read Historic Data
• Analyze Data

LabVIEW

• View Data

Remote Computer

Historic
Data

Internet (DataSocket)

• Configure and Test Board
• Configure and Test Virtual Channel

MAX

• Define Task
• Execute Task
• View Data
• Export to ASCII
• Print Graph

VI Logger

• Publish to DataSocket
• Log data
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configuration dialog boxes. Refer to Chapter 2, Creating and Running a
VI Logger Task, for information about the measurement system
components that you need to configure and instructions to set up and use a
VI Logger task.

A VI Logger task requires the following three pieces of information:

• Task name

• DAQ measurement device

• One or more virtual channels to acquire and log data

To see these three pieces, navigate through the MAX hierarchy. VI Logger
tasks are listed under the VI Logger Tasks category. DAQ virtual channels
are organized under Data Neighborhood and DAQ devices are stored under
Devices and Interfaces.

You can further define a task by defining the following additional options:

• Per-channel scan rate

• Start and stop conditions for your task

• Events

– Detection (high, low, outside/inside range)

– Action (turn logging on/off, write analog output value, write to
digital line, pop-up message, send an e-mail, and make sound)

• Calculated channels

• Data publishing to DataSocket

Once you have defined a task, you can easily execute it and view the data
using VI Logger. With the calculated channels feature, you can perform
mathematical functions on virtual channels and log these calculated
channels. With DataSocket publishing, while logging a task, you can
publish your data over the Internet and retrieve and view the data on a
remote computer. When a task is finished, you can select all or some of the
data and export the data to a text file from any specified task run. This text
file can be read by spreadsheet programs or by a Web browser if you export
data using an HTML template. Refer to the Loading an HTML Export
Template section in Chapter 2, Creating and Running a VI Logger Task, for
more information about using an HTML template to format exported data.
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Using VI Logger VIs in LabVIEW
You can add functionality to VI Logger by using the LabVIEW VI Logger
VIs, to execute data logging tasks and retrieve historical data, in
conjunction with other LabVIEW VI libraries. For example, use the
mathematical and analysis functions in LabVIEW to perform real-time
analysis.

Checking Your System Requirements
Before you unpack and install your VI Logger software kit, make sure you
have the following necessary system requirements to run this system:

• Windows 2000/NT/Me/9x

• DAQ device—VI Logger works with E Series, NI 435X, and NI 611X
devices

Installing Your Hardware
For instructions for installing your hardware, refer to your hardware
installation document.

Installing Your VI Logger Software
To install VI Logger, insert the VI Logger CD in your CD-ROM drive, and
follow the instructions that appear on your screen. Click Finish when the
installation is complete. You can then access the VI Logger utility through
MAX. See Chapter 2, Creating and Running a VI Logger Task, for more
detailed instructions on using VI Logger.

Configuring and Testing Your Hardware
Once you have installed your hardware, configure and test it using the
instructions contained in your hardware installation guide or user manual.
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2
Creating and Running a
VI Logger Task

This chapter explains how to configure and run a task using VI Logger and
how to view or export the resulting data.

Configuring, Modifying, and Testing
Your Measurement Device

Before you create a VI Logger task, you should configure and test at least
one measurement device and one virtual channel to verify the operation of
your data logging hardware. While most DAQ devices that are supported
by VI Logger are plug and play, you should make sure that they are set up
correctly. In the Devices and Interfaces category of MAX, check to see if
your device is listed. Modify and test the device by selecting it and using
toolbars supplied with the device.

Note If you have a plug and play device and it does not appear under Devices and
Interfaces in MAX, press <F5> to refresh the list of devices. If it still does not appear, then
refer to the installation instructions for the NI-DAQ board.

Using an RDA Device with VI Logger
If you want to use a remote device access (RDA) device, VI Logger
supports E Series, NI 435X, and NI 611X devices, which you can access
directly on your computer or via the RDA server for a device. The RDA
server is documented in detail in your device user manual.

There are certain limitations to using an RDA device with VI Logger. If you
are using an RDA device, it is essential that the system clocks of the client
and server computers are synchronized. If the client clock is ahead of the
RDA server clock, the data will appear to be old data. If the RDA server
clock is ahead of the client clock, the client will not be able to display any
data until its clock catches up to the time that the data started being logged
according to the RDA server computer. Also, if you use an RDA device
with VI Logger, any action involving digital lines will not work.
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If your device does not support plug and play or if you are using a device
across the Internet as an RDA device, then you need to register and
configure it manually on your computer. Refer to the instructions supplied
with your DAQ device for information about installing and configuring an
RDA on your computer.

Creating Virtual Channels
Before you create a VI Logger task, you need to first create a virtual
channel and test it. Complete the following steps to create the virtual
channels to use in your data logging task.

1. Launch the Measurement & Automation Explorer.

2. In the MAX configuration tree, right-click Data Neighborhood and
select Create New from the pop-up menu.

3. The Create New Channel wizard opens. Follow the wizard instructions
to create your new virtual channel.

Modifying Virtual Channels
Complete the following steps to modify a virtual channel.

1. In the configuration tree of MAX, right-click a virtual channel under
Data Neighborhood.

2. Select Properties.

3. Make any modifications necessary in the Properties window that
appears.

4. Select OK when you are finished.

Testing Virtual Channels
The Virtual Channel Test Panels show actual readings so you can directly
control the different channels you have configured. Complete the following
steps to test the virtual channels.

1. In the configuration tree of MAX, right-click a virtual channel under
Data Neighborhood.

2. Select Test.

3. View the readings and change any parameters in the Virtual Channel
Test Panels.

4. Click Close when you are finished.

Note For information on panel items or buttons, right-click an item and select
What’s This?
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VI Logger Basics
With VI Logger, you can configure your logging task. VI Logger provides
feedback if any choices you make are invalid. VI Logger defines a logging
task by determining the following information:

• Acquisition Settings—On the Task Attributes page, you can select the
device from which you want to acquire and log data, enter the scan per
channel rate for each channel, and set the buffer settings.

• Logging Conditions—On the Task Attributes page, you can set when
and how the logging begins.

• Network Publishing—From the Task Attributes page, you can
publish your data to DataSocket, which enables you to access the data
through a network.

• Acquisition Conditions—On the Task Attributes page, you can define
the acquisition conditions in which the task will run. The measurement
task can be started and stopped at a specific time. Also, measurement
tasks allow a variety of hardware triggering conditions.

• Virtual Channels—On the Virtual Channels page, you can view the
list of virtual channels you created under Data Neighborhood. You can
choose to enable logging for each of these channels on this page.

• Calculated Channels—If you need to perform some arithmetic
transformations on the measured data, on the Calculated Channels
page you can define new channels based on acquired channels. You can
define linear combinations of two channels, logarithmic or normalized
logarithmic of acquired channels (dB and dBv), or define a custom
function of multiple acquired channels.

• Events—Use events on the Virtual and Calculated Channels pages to
control stop and start logging conditions.

Creating and Configuring Your Task Using VI Logger
Launch VI Logger by selecting Start»Programs»National Instruments»
VI Logger. Complete the following steps to create a data logging task.

1. In the configuration tree in MAX, right-click VI Logger Tasks and
select Create New. The Create New dialog box appears.

2. Select Logging Task and click Finish. In the MAX configuration tree,
the newly created task is selected and the Task Attributes tab is
selected.
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VI Logger automatically gives your task a unique default name, which
appears in the task name field as Logging Task. You can rename your
task by deleting the default task name and entering a new name in the
task name field.

3. In the Acquisition Settings section, Device field, click the down arrow
to select the device you are using.

4. In the Acquisition Settings section, Scan Rate (scans/sec) field, use
the default scan rate or enter the rate at which you want to acquire data
per second.

Tip You cannot log data from more than one device per task; however, you can define one
task for each device and can run more than one task at the same time.

5. In the Buffer Settings section, you can define buffering parameters for
the task. With these parameters, you can modify the performance of VI
Logger, specifically if you are trying to log data at a high rate.
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Setting Up the Virtual Channels in Your Task to Acquire and Log Data
For each VI Logger task you configure, you can select which specific
channels acquire and log data within that task.

Complete the following steps to set up the channels that acquire and log
data.

1. Click the Virtual Channels tab.The following configuration view
appears.

Tip Right-click the Events column heading and select Events to enable or disable the
information displayed in the table.

2. The Active Channel column displays all the virtual channels you have
created in MAX for your device. To enable logging on each channel,
click the Log Enabled? box to the right of each channel name.

Tip To add a virtual channel, click Create channel and follow the instructions in the
Create New Channel wizard.
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3. To configure an event, right-click the Events column and select
Events. Check and uncheck the desired events. You can also
right-click the table cells to access more options to modify these
conditions.

Refer to the Creating Calculated Channels section for information about
creating calculated channels for VI Logger tasks.

Setting the Logging and Data Acquisition Conditions
You can define both logging and acquisition conditions for your task.
Logging occurs when the data is actually being logged to where you want
to store the data. Acquisition occurs when the data is being acquired and is
available for viewing in the Real Time Data tab. The data is not necessarily
being logged anywhere, although you can both acquire and log data at the
same time. There are four ways to set up your task using VI Logger that are
discussed in the following sections.

Using the Default Acquisition and Logging Settings
for Your Task
In the Task Attributes tab, Logging Conditions section, the Begin
logging when acquisition starts checkbox is enabled by default. When
you use the default logging and acquisition settings for your task, you can
optionally set the acquisition stop condition and then save and run the task
with this condition, or you can just click Stop Task to stop acquisition.
After you click Run Task, both the data acquisition and the logging
immediately start at the same time. Logging and acquisition stop when you
click Stop Task or when your stop acquisition condition is met. The
following figure illustrates this default scenario.
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Refer to the Setting a Stop Condition for Acquiring Data section for
instructions to set an acquisition stop date and time.

Using Conditional Acquisition for Your Task
In addition to setting up start and stop conditions for logging, you can also
set start and stop conditions for acquiring data in your task. To learn how
to set up conditional logging conditions in your task, refer to the Using
Conditional Logging for Your Task section.

Setting Start Conditions for Acquiring Data
There are three ways to start acquiring data. The first way is to start
acquisition on a particular date and time. The second way is to start
acquisition with a trigger. The third is a combination of the two above,
where the DAQ hardware searches for a digital trigger after a specific start
time is met. Refer to the Using Both Conditional Acquisition Triggers and
Conditional Logging for Your Task section for further details on this
feature.

Note When you start acquisition, you start acquisition on the virtual channels selected in
the Log Enabled? column of the table for a task.

VI Logger Task: Default Acquisition and Logging

When you...

VI Logger...

press Run Task,

starts acquiring and logging data.

press Stop Task, or the
acquisition stop condition is met,

stops acquiring and logging data.

Logging task

Data acquisition

Logging operation
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Setting a Date and Time Start Condition for Acquiring Data
Complete the following steps to set an acquisition start condition using a
date and time.

1. Click the Task Attributes tab.

2. In the Acquisition Conditions, Date and Time section, enable the
Start acquisition checkbox.

3. Enter a date and time when you want to start acquiring data.

To begin acquiring data, click Run Task. To stop acquiring data, either wait
for the stop acquisition date and time to be met or click Stop Task.

Verify changes to your acquisition settings by clicking Save Task.

Setting a Trigger Start Condition for Acquiring Data
Complete the following steps to set the acquisition start conditions using a
trigger.

1. Click the Task Attributes tab.

2. In the Acquisition Conditions, Trigger section, enable the
Start acquisition on trigger checkbox to apply any triggered start
conditions to your task.

3. In the Acquisition Conditions, Trigger section, select the appropriate
start conditions in the active fields that apply to the trigger. To get a
more detailed description of what each field does, right-click its label
and select What’s This?

Setting a Stop Condition for Acquiring Data
The only stop condition you can set to stop acquiring data for the task is the
date and time. You can also stop the task by manually selecting the Stop
Task button. Complete the following steps to set the date and time stop
condition.

1. Click the Task Attributes tab.

2. In the Acquisition Conditions, Date and Time section, enable the
Stop acquisition checkbox.

3. Enter a date and time when you want the task to stop acquiring data.

To begin acquiring data, click Run Task. To stop acquiring data, either wait
for the stop acquisition date and time to be met or click Stop Task.
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Note When you set the acquisition start and stop conditions, you still need to start your
task manually by clicking Run Task. Once you have begun the task, VI Logger waits for
the appropriate start conditions to begin acquiring data, and then stops when the stop
condition is met.

The following figure demonstrates what happens in VI Logger when you
set start and stop conditions for data acquisition.

Using Conditional Logging for Your Task

Note Turning logging on and off does not affect the task. Click Stop Task or set a stop
task condition to stop logging.

You can either log some or all of the channels within a task. You can
configure the task to start logging when you run the task, or you can
configure an event to start logging data. Use the Control logging with
digital channel checkbox on the Task Attributes tab to control logging for
the task. You configure events to control logging by right-clicking the
Events column of the table on the Virtual Channels or Calculated Channels
tab, and selecting Events. Check or uncheck events from the drop-down
menu to configure logging events. The following figure illustrates what
happens in VI Logger when you set up conditional logging.

When you...

VI Logger...

press Run Task,

starts acquiring and
logging data.

press Stop Task, or the
acquisition stop condition is met,

stops acquiring and logging data.
starts waiting for

acquisition start time
(if one is configured).

configure an acquisition start
trigger and the condition

is met,

configure an acquisition start
time and the time

is reached,

starts waiting for
acquisition trigger

(if one is configured).

Logging task

Data acquisition

Logging operation

VI Logger Task: Conditional Acquisition
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There are three ways to control the logging of your task, which are
described in the following sections.

Using Default Settings for Logging
You can use the default settings to control logging for your task. When you
use the default settings, you start logging when you click Run Task and
stop logging when you either click Stop Task or your stop data acquisition
condition is met. Refer to the Setting Up an Event Detection section for
information about using events to control logging.

Using Channel Events for Logging

Note This feature is available for both the virtual and calculated channels. When the term
channel is used throughout this section, it is referring to both virtual and calculated
channels.

You can also control start and stop logging conditions using the channel
events feature. Refer to the Setting Up an Event Detection and Setting Up
an Event Action sections for more information about using the channel
events feature.

Setting Up an Event Detection
An event is similar to a DAQ trigger. When a specific condition occurs,
VI Logger performs a specified action. The specific condition is called an
event detection.

Note You can only configure one event per channel.

VI Logger Task: Conditional Logging

When you...

VI Logger...

press Run Task,

starts acquiring data.

press Stop Task, or
the acquisition stop

condition is met,

stops acquiring data.starts logging data. stops logging data.

configure a logging start
condition and the condition

is met,

configure a logging stop
condition and the condition

is met,

Logging task

Data acquisition

Logging operation



Chapter 2 Creating and Running a VI Logger Task

© National Instruments Corporation 2-11 Getting Started with VI Logger

Note By default, all channels are configured without an event defined for them.

Complete the following steps to set up event detection.

1. In either the Virtual Channels or the Calculated Channels tab,
Active Channel field, right-click a channel name for which you want
to set an event.

2. Select Events to open the Event properties for dialog box.

3. Click the Event Detection tab.

4. Under Event Type, select the type of event. The type of event you
select determines which fields may appear in the dialog box for you to
customize.

• If you select Outside Range in the Event Type field, in the
Range Min and Range Max fields, enter the minimum and
maximum range for the event.

• In the Deadband field, enter a value to prevent noise in the signal
from triggering multiple events. A higher value provides greater
noise immunity. The value is in the same units as the channel.
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• In the High field, enter a high limit to trigger a High, Outside
Range, or Inside Range event. The units are the same as for the
channel.

• In the Low field, enter a low limit to trigger a Low, Outside Range
or Inside Range event. The units are the same as for the channel.

5. Refer to Setting Up an Event Action to finish configuring your task
event.

Setting Up an Event Action
The event action is what you want done once VI Logger detects the specific
event condition.

Complete the following steps to set up event action.

1. Click the Event Action tab. The Event properties for dialog box
appears.



Chapter 2 Creating and Running a VI Logger Task

© National Instruments Corporation 2-13 Getting Started with VI Logger

2. Under Action Type, click the down arrow and select an event action.
As necessary, customize any additional fields that appear when you
make your selection.

The event actions that you can select are as follows:

• No Action—Nothing happens when VI Logger detects an event
condition.

• Write to Digital Line—Writing to a DAQ digital output line.

• Write to Analog Channel—Writing to an analog output channel.

• Pop Up Message—Message appears.

• Send Email Message—Sending e-mail to the user account. Refer
to Appendix B, Setting Up an Event E-mail, for details on how to
use this feature.

• Sound—Using multimedia, such as a beeping terminal (sound).

• Toggle Logging—Changes between logging on and logging off
states.

• Turn Logging Off—Turns logging off when the event detection
condition occurs.

• Turn Logging On—Turns logging on when the event detection
condition occurs.

3. Click OK to save the new event detection and action settings for your
event.

4. Click Save Task to save your changes in the task.

Refer to the Modifying Your Task section for more information about
modifying a task before running.

Using a Digital Channel to Control Logging

Note To use this feature you must already have a virtual channel set up for digital line
input.

Using the Control Logging with digital channel feature, you can control
logging with a digital channel. You can wire a hardware switch to one of
your digital input virtual channels to control when a task logs. When the
line is high, logging is enabled. When the line is low, logging is disabled.
For detailed information on setting up your hardware switch, refer to your
device documentation.
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Complete the following steps to set up the start conditions for logging a
task.

1. Verify you have a digital input channel for which to toggle logging.

2. In the MAX configuration tree under Data Neighborhood, right-click
the digital input line virtual channel and select Test. Test the virtual
digital input channel by flipping the hardware switch on or off and
verifying if it powers on or off the LED in the software test panel in
MAX.

3. In the Task Attributes tab in the Logging Conditions section, select
Control Logging with digital channel.

4. Click the down arrow in the activated field and select Digital channel
name.

As you toggle the hardware switch, you toggle the data logging on or off.
Each time you turn logging on, a new date and time run appears under the
VI Logger task name in the MAX configuration tree.

Using Both Conditional Acquisition Triggers and
Conditional Logging for Your Task
When you set up both conditional acquisition and conditional logging, the
following figure illustrates what happens in VI Logger. If you set both start
time for acquisition and a trigger for starting logging, the start time begins
acquisition, the trigger begins logging, and then your logging conditions
are evaluated. Refer to the Using Conditional Acquisition for Your Task
section for detailed information on setting up conditional acquisition. Refer
to the Using Conditional Logging for Your Task section for detailed
information on setting up conditional logging.

VI Logger Task: Conditional Acquisition and Logging
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VI Logger ... starts acquiring data. stops acquiring data.
starts waiting for

acquisition start time
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Setting Up Network Publishing to View
Your Data from Another Computer

With network publishing, on your host computer, you can specify a specific
URL where you want to publish the data so you can monitor the data from
that location. You can use a tool like LabVIEW to create a DataSocket
client for the web.

Complete the following steps to publish data using your network.

1. Click the Task Attributes tab.

2. In the Network Publishing section, enable the Publish to DataSocket
checkbox. The URL field below that specifies where you want to
publish data.

3. In the URL field, enter a URL of a client computer from where you
want to monitor the data being acquired and logged from your task.

4. If you have LabVIEW, you can refer to the LabVIEW DataSocket
example VI provided to view the data from the client computer.

Creating Calculated Channels
With math channels, you can set up mathematical equations using virtual
channels. For example, for channels Channel 0 and Channel 1, you could
type the equation Channel 0 - Channel 1 to subtract one from the other.
The result would be a calculated channel.
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Complete the following steps to create a calculated channel.

1. Click the Calculated Channels tab.

2. Click Create channel. The Math Expression Editor dialog box
appears where you can define your math channel.
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3. In the Channel Settings section in the Name field, enter an
appropriate name for your math channel.

4. In the Units field, enter the appropriate unit type.

5. In the Minimum and Maximum fields, enter a range of units that
apply to your math channel.

6. In the Formula Settings section in the Formula field, click the down
arrow, and select one of four formulas to apply to your math channel,
which are as follows:

• Ax (Op) By + C—This is a linear combination formula. Fill in
fields A, Channel X, Operation, B, Channel Y, and C with the
appropriate values.

• db x/y—A measurement of noise (db)–power base 10. Select the
channels you want for Channel X and Channel Y fields.

• dBVx—A single channel noise measurement. Select the channel
you want for the Channel X field.

• User Defined—Enter a formula into the User defined formula
field. Refer to Appendix A, Math Expression Editor
Function Descriptions, for a complete detailed list of the valid
functions you can use in this field.

7. Click OK.

Modifying Your Task
Once you have created your task, you may want to modify the task.
Complete the following steps to modify a task.

1. In the MAX configuration tree, expand VI Logger Tasks. Click your
task name. The summary of your task configuration appears in four
tabs in the configuration view: Task Attributes, Virtual Channels,
Calculated Channels, and Real Time Data. To access one of these
views, click the tab at the bottom of the MAX screen.

2. Modify your task by changing any information in the appropriate
fields.

You are now ready to run your new data logging task. Running a task
automatically saves the modified task.
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Duplicating Your Task
To save time when configuring more than one task, you can duplicate your
task and then modify anything in it. Complete the following steps to
duplicate a task.

1. Right-click the task in the MAX configuration tree and select
Duplicate. The Duplicate a VI Logging task dialog box appears.

2. Enter a task name in the New task name field.

3. Click OK.

The duplicate task appears in the MAX configuration tree at the end of the
task tree.

Deleting Your Task and Data
Complete the following steps to delete an entire task.

Caution When you delete a task, all data associated with that task will also be deleted.

1. Right-click the task in the MAX configuration tree and select Delete.
A MAX-VI Logger dialog box appears asking you to confirm that you
want to delete the task.

2. Click Yes to delete the task or click No to cancel the deletion.

Running Your Task
Complete the following steps to run a task.

1. Select the task you want to run in the MAX configuration tree.

2. Click the Run Task button below the menu toolbar.

Let the task run for several seconds to acquire some data. Click Stop Task
to stop running the task, or wait for your stop condition or trigger to occur.
The data is collected and stored by MAX. You may also store the data by
enabling the Publish to DataSocket checkbox in the Task Attributes tab to
send the data to DataSocket to view from a remote computer.
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Stopping Your Task
If you set a stop condition for your task, it stops acquiring and logging
automatically. If you do not specify stop conditions when you create your
task, your task normally runs until you manually click the Stop Task
button.

Viewing Your Data

Tip You can move the Task Attributes, Virtual Channels, Calculated Channels, and Real
Time Data tabs around to dynamically interchange them. You can also separate the tab
from the MAX interface by clicking and dragging the tab away from the MAX dialog box.

When you view your logged data, you can view data such as the start and
stop time, engineering units measured, minimum and maximum value set
for the channel after scaling, and number of scans. In addition, you can
view your data in a display view before, during, or after the data is logged.
Complete the following steps to view the logged data.

1. In the MAX configuration tree under VI Logger Tasks, click your task
name.

2. Click the run you want to view.

3. If not already selected, click the Trace Attributes tab. The following
configuration view appears.
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From this view, you can find the following information about the task
you ran:

• Start time—Time task began

• End time—Time task ended

• Name—Channel name from which the data was logged

• Units—Engineering units measured

• Minimum—Minimum value set for that channel after scaling

• Maximum—Maximum value set for that channel after scaling

• # of Scans—Number of times the channel was scanned

• Scaled—Yes means the data was scaled before it was logged. No
means the data was not scaled before it was logged.

Viewing Your Data Graphically
Click the Historical Data tab at the bottom of the configuration view to see
the graphical view of the data logged from each channel.
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Monitoring Your Acquired Data
There are two tabs available where you can view your data. The first
display tab, Real Time Data, is available when you select a task name in the
Configuration view. You can use this display to monitor data that is being
acquired, regardless of if the data is being logged or not. VI Logger
automatically jumps to this tab to monitor the data when logging starts. For
high-speed data logging, you can disable this default behavior by removing
the check from the Jump to the Real Time Data tab when task starts
checkbox on the Task Attributes tab.

Viewing Your Logged Data
The Historical Data tab appears when you select a run under the task name.
This tab shows only your logged data that has already been stored in the
task run, as shown in the following figure.
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Plotting Your Data
A red and green LED indicator appears on the upper right corner of the
Historical Data tab and the Real Time Data views when you are running the
task. If the green light is lit, you are viewing the task data while it is being
acquired, which means that the data on the screen reflects what is currently
being acquired. If the red light is lit, you are viewing the data that has
already been collected and logged.

• To switch between viewing current and historical data, click the LED
indicator. You can only switch between viewing current and historical
data if a task is running.

• To snap the view to the beginning of the logged data, click once on the
home arrow button. To snap the view to the end of the data, click once
on the end arrow button.

• To scroll back and forth through the logged data, click several times on
the forward or backward scroll arrows. To scroll faster through the
data, click the forward or backward scroll arrow buttons, and drag your
cursor to the right or left of the arrow buttons and hold the mouse
button down for it to scroll faster left or right. The further away you
drag the cursor from the arrow, the faster the data scrolls.

Zooming In or Out on Your Data
Click the magnifying glasses at the top of the display view to zoom in or
zoom out on the current view. The view is magnified twice or decreased by
half on the x-axis as you zoom in or out.

Additionally, in the display view, you can click and drag to the right or left
to zoom in on the x-axis data. You can also right-click in the view, select
Zoom/Pan Mode, then click in the view and drag the square for the x- and
y-axis area you want to magnify. Then select the zoom out magnifying
glass on the top of the window to zoom out again.
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Modifying Your Plots or Display View
Complete the following steps to modify plots or display view.

1. Right-click in the graphical view and select Properties. The
HyperTrend Properties dialog box appears.

In the Groups section, you can modify the following fields:

• Name—Specifies the group display plots and view that you are
modifying

• Caption—Describes the group and the text then appears beneath
the Real Time Data view

• Background—Modifies the background color in the view
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• Default Width—The default width of the entire Real Time Data
view is one second from beginning to end. You can enter any time
frame in the Default Width field to change what amount of data
you see in the view. Once you are in the Real Time Data view and
you make modifications to the width of the view, you can
right-click and select Restore X-axis width to return to the
default width.

• Background—Click the down arrow to modify the background
color of the Real Time Data view.

• Major Grid—Click the down arrow to modify the color of the
major grid lines. Select the Visible box if you want the major grid
lines to show.

• Minor Grid—Click the down arrow to modify the color of the
minor grid lines. Select the Visible box if you want the minor grid
lines to show.

• Stacked Plots—Select this box to split the plots into stacked plots
in the view instead of plots that are on top of each other.

2. Under Channels/Traces, select the channel on which your task ran.
Click the up and down blue arrows to change the order of the channels
as they appear to the right of the display. Additionally, you can add,
edit, or delete the channels from the view by clicking the buttons
beneath the channels.

3. In the Channels/Traces section, you can modify the following fields:

• Name—The name of the channel appears in this field

• Minimum and Maximum—Enter a number to adjust the y-axis
height of the plot

• Line—Click the down arrow button to select a line color. You can
also modify the style and width in the Style and Width fields next
to the color.

• Data Point—Click the down arrow button to select a line color.
You can also modify the style in the Style field next to the color.

• Event—Click the down arrow to select a line color. You can also
modify the style and width in the Style and Width fields next to
the color.

4. Click Apply to apply your modifications to the Real Time Data view.

5. Click OK to exit the HyperTrend Properties dialog box.

6. Right-click in the Real Time Data tab and select Fixed Grid to make
additional modifications to the view. With this feature checked, the
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grid stays in one place while the data still scrolls in the view. With this
feature unchecked, the grid moves with the data as it scrolls.

Modifying the Legend
The legend is the area to the right of the display view that shows your
channel names from which the data is taken. To modify the legend or
channels in the legend, follow these steps:

1. Right-click the channel name you want to modify in the legend and
select one of the following items:

• Display—When you check this item, it displays the channel you
selected in the legend and shows the data plot from that channel in
the view.

• Hide—When you check this item, it grays out the channel you
selected in the legend and does not show the data plot in the view.
You can also double-click the channel name to hide it. To display
the channel again, double-click the grayed out channel name.

• Select All—When you check this item, it selects all the channels
in the legend so you can modify them all at once. You can also
select more than one channel by pressing <Ctrl+Shift> while
clicking a channel.

• Rename—You can enter a different channel name when you
select this item.

2. To hide or show the legend, right-click in the graph area, and select
Show Legend, depending upon which is needed.

3. Click the channel name colored box to change the plot color in the
view.

Determining Time Difference, Frequency,
and Values Using Plot Cursors

If you have a periodic waveform to view, use this feature to measure the
time difference between two points in the display or to calculate the
frequency of a periodic waveform. With the Display Cursors feature, you
can see the value of a plot wherever you place a cursor, which appears as a
green vertical line in the displays view. You can also get the time difference
between two cursors that you place on the plot, and you can get the inverse
of that, which is the frequency.
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Complete the following steps to change the cursor displays.

1. Click the Cursor button located above the display view to access the
Display Cursors dialog box.

2. Select the Two Cursors box to be able to use two cursors at the same
time in the view.

• First Cursor and Second Cursor—You can modify the date and
time of where the cursor is placed in the view using these fields. If
you run the task for more than one day, then you might need to
modify the day.

Note Time Diff and Freq fields are hidden if the Two Cursors checkbox is not checked.

• Time Diff—The time difference is calculated between the two
cursors. The maximum time that will show in this field is the
maximum width of the view window.

• Freq—Calculates the inverse of the Time Diff field, which is the
frequency.

3. Click Close to exit from the dialog box.

Printing Your Data
To print the data graph, right-click in the Historical Data or Real Time Data
display view and select Print. You can only print what is showing in the
view on your screen.
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Exporting Your Data
To export your data to another file, under VI Logger Tasks, right-click a
run, and select Export Data. The Export data dialog box appears as
shown in the following figure.

• Source—File path where the database source to export is located.

• Start time—Time stamp on the first point returned in the data plot.
You can manually change this field. This date and time are the
startDate and startTime variables in the Advanced export settings
dialog box.

• End time—Time stamp on the last point returned in the data plot. You
can manually change this field. This date and time are the endDate and
endTime variables in the Advanced export settings dialog box.

• Field Delimiter—Use this option to select what is placed between the
different fields in your data in the export file. For example, you can
separate the fields in your export file with a comma or a tab. This field
is the delimiter variable in the Advanced export settings dialog box.

• Output file—File path where data is exported. You need to name the
export file in this field before you generate it. Use any file extension
and include the complete path to the file.

• Writing rows—Progress bar that monitors the export function.

• Start—Starts generating the export file.

• Cancel—Interrupts the export function and exits the Export data
dialog box without saving any changes.
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• Advanced—Accesses the advanced programming options, such as the
header and footer formats, and variables you want to appear in your
export file. Refer to the Setting Advanced Export and Programming
Options section for further details on this feature.

Setting Advanced Export and Programming Options
To access the advanced programming options feature, click Advanced in
the Export data dialog box. Refer to the Exporting Your Data section for
more information about exporting data. The Advanced export settings
dialog box appears, as shown in the following figure.

A description of the Advanced export settings dialog box fields follows:

• Header format—Enter the header that you want to appear in your
export file. You can use variables in this field.

• Row format—Enter the way you want the row of data to be formatted.
You can use variables in this field.

• Footer format—Enter the footer that you want to appear in your
export file. You can use variables in this field.

• Variables—Variables contain values that can vary depending upon the
task from which you are pulling data. Refer to the Variables section for
more information about using variables with VI Logger.
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• Load—Use this button to load predefined templates included with VI
Logger or a template you created and customized. Refer to the
following sections for more information about loading templates.

• Save—Use this button to save any customized formats.

Loading a User-Defined Export Template
You can load a user-defined template, which is included with the VI Logger
software. Complete the following steps to load a user-defined template.

1. Right-click a run in the MAX configuration tree and select Export
Data. Click Advanced to open the Advanced export settings dialog
box.

2. In the Advanced export settings dialog box, click Load. The Load
export template dialog box appears.

3. Select default.vet from the VI Logger\Export folder and click
Open. The Advanced export settings dialog box now contains the
default template settings.

4. Click OK to apply the template formatting to the data you are
exporting.

Loading an HTML Export Template
You can format your data into HTML by loading an HTML template,
which is included with the VI Logger software. Once you apply the HTML
format to your data, you can then view your data using a browser such as
Microsoft Internet Explorer. Complete the following steps to load the
HTML template.

1. Right-click a run in the MAX configuration tree and select Export
Data. Click Advanced to open the Advanced export settings dialog
box.

2. In the Advanced export settings dialog box, click Load. The Load
export template dialog box appears.

3. Select html.vet from the VI Logger\Export folder and click
Open. The Advanced export settings dialog box now contains the
default template settings.

4. Click OK to apply the template formatting to the data you are
exporting.
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Modifying the Template
You can modify the template or create your own template by altering the
Header format, Row format, and Footer format fields and saving the
modified template with a new name. Complete the following steps to save
custom export settings.

1. Right-click a run in the MAX configuration tree and select Export
Data. Click Advanced to open the Advanced export settings dialog
box.

2. In the Advanced export settings dialog box, click Save to save the
export settings you customize. The Save export template dialog box
appears.

3. Enter filename.vet.

4. Select the folder where you want to save the new template. The default
folder is C:\Program Files\National Instruments\VI 
Logger\Export.

5. Click Save to save your file to this path.

Variables
Variables contain values that can vary depending upon the task from which
you are pulling data. There are two types of variables that you can use to
program specific text and data into your export file: global and index list
row format. You can program what variables and text you want to appear
in the header and footer of your export file using the Header format and
Footer format fields, and you can program how you want the rows of data
to be presented using the Row format field. Refer the following tables for
specific descriptions and categories of the variables.

Global
Global variables are variables that apply to the entire export file, meaning
that you can use these variables in all three fields in the dialog box: Header
format, Row format, and Footer format. The global variables and
descriptions are in the following table.

Global Function Description

repeat (N, X, Y, “S”) Refer to the Repeat Function section for a
detailed description of the repeat variables
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Global Index

One Value
One value variables contain only one value.

Table 2-1. Global Variables

Variables Description

name [N] N=[0...numChannels). Name of channel on the
N channel trace.

delay [N] N=[0...numChannels). How long it took to
take measurement from time of scan on the
N channel trace.

units [N] N=[0...numChannels). Units that appear in the
VI Logger summary view for the N channel
trace.

Table 2-2. One Value Variables

Variables Description

creationDate Date that exported file is created

creationTime Time that exported file is created

delimiter The delimiter selected in the Field Delimiter
field in the Export data dialog box

deltaT Scan rate (in seconds) for logged task that
produces plot or run

endDate End date specified in export dialog box

endTime End time specified in export dialog box

startDate Start date specified in export dialog box

startTime Start time specified in export dialog box

numChannels Number of virtual channels that appear in the
VI Logger Trace Attributes tab. Amount
equals total number of channels when you
combine the numRegChannels and
numCalcChannels variables.

rows Number of total rows of data exported
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Index List Row Variables
Index List Row variables are variables that you can only use in the Row
format field. The Row format variables with their description are given in
the table that follows.

One Channel Value in a Row Export Variables

numRegChannels Number of virtual channels excluding
calculated channel

numCalcCchannels Number of calculated channels only

Table 2-3. Index List Row Variables

Row Format Variables Description

row Row number (0 to number of scans)

date Date of current row

time Time of current row

timeOffset Time of scan since the start of the export:
Row number × deltaT

Table 2-4. One Channel Value in a Row Export Variables

Row Format Variables Description

value[N] N=[0...numChannel). Value of the N channel
trace in the current row.

Event [N] N=[0...numChannels). Event of the
N channel trace in the current row.

Table 2-2. One Value Variables (Continued)

Variables Description
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Repeat Function
You can use the Repeat (N, X, Y, “S”) function for string replacement. For
example, you can use this function when you have ten channels in one run
and five channels in another run, and you need to alter the number of
channels in the runs.

Special Syntax Characters
There are four different special syntax characters that you can use in the
repeat function. They are described in the table that follows.

Table 2-5. Syntax Characters for Repeat Function

Character Description

N String which needs to be replaced in S

X Beginning value of N, the valid range is between
[0..numChannels)

Y Ending value of N, the valid range is between
[0..numChannels)

“S” Statement whose value N will be replaced

Table 2-6. Special Syntax Characters for Repeat Function

Syntax
Characters Description

plain text Any plain text character is output to export file
verbatim

[ ] Used for channels only for indexing into a
variable that has multiple channels

" " Whatever text or characters are inside the quotes
are output verbatim in the export file

\ Outputs verbatim whatever follows the backslash,
unless the backslash is inside quotes

{ } Indicates the start or end of the variable or
function
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Export Template Examples

Export All Channels Plus Associated Events
Enter the following text in the Advanced export settings dialog box fields:

Header Format

NI (c) VILogger v1.0

Created: {creationDate} {creationTime}

Number of scans: {rows}

Scan rate: {deltaT} seconds

Number of total channels: {numChannels}

row {delimiter} time{delimiter} 

{repeat(###,0,{numChannels},”{name[###]} {delimiter} 

{name[###]}.”event” {delimiter}”)}

Row Format
{row} {delimiter} {time} {delimiter} {repeat(###, 0, 

{numChannels}, “{value[###]} {delimiter} {event[###]} 

{delimiter}”)}

Export Regular Virtual Channels Only
Enter the following text in the Advanced Export settings dialog box
fields:

Header Format
NI (c) VILogger v1.0

Created: {creationDate} {creationTime}

Number of scans: {rows}

Scan rate: {deltaT} seconds

Number of virtual channels: {numRegChannels}

row {delimiter} time{delimiter} 

{repeat(###,0,{numRegChannels},”{name[###]} 

{delimiter}”)}

Row Format
{row} {delimiter} {time} {delimiter} {repeat(###, 0, 

{numRegChannels}, “{value[###]} {delimiter}”)}
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Export Calculated Channels Only
Enter the following text in the Advanced Export settings dialog box
fields:

Header Format
NI (c) VILogger v1.0

Created: {creationDate} {creationTime}

Number of scans: {rows}

Scan rate: {deltaT} seconds

Number of calculated channels: {numCalcChannels}

row {delimiter} time{delimiter} 

{repeat(###,{numRegChannels},{numChannels},”{name

[###]}{delimiter}”)}

Row Format
{row}{delimiter}{time}{delimiter}{repeat(###, 

{numRegChannels},{numChannels},“{value[###]}

{delimiter}”)}

Creating a New Database
The VI Logger database is where your task runs are stored. Complete the
following steps to create a new database.

1. Select Tools»VI Logger»Database. The Database dialog box
appears. If this is the first time you are creating a database, the default
database path should already be checked.

2. Click Create New. The Create Database dialog box appears.

3. Enter a descriptive name for the new database.

4. Enter a file path for the database.

5. Click OK. The Database dialog box appears with the new name and
path where data is being stored.

6. If you want to store your task runs to your new database, right-click the
new database, and select Set as Default or double-click the database.
A check mark appears to the left of the database name.

7. Click OK.

Once you have created a database, you can compact, delete, and rename the
database.
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Compact a Database
To save disk space, you can compact a database in VI Logger. Complete
the following steps to compact a database.

1. Select Tools»VI Logger»Database. The Database dialog box
appears.

2. Right-click a database and select Compact.

Rename a Database
Complete the following steps to rename a database in VI Logger.

1. Select Tools»VI Logger»Database. The Database dialog box
appears.

2. Right-click a database and select Rename.

3. Type the new name for the database.

Delete a Database
Complete the following steps to delete a database.

1. Select Tools»VI Logger»Database. The Database dialog box
appears.

2. Right-click a database and select Delete.

Exporting a Task to Another Computer
You can export your defined task in XML format and import it to a
destination computer. To export your task to another computer, you need
to set up the DAQ configuration and the task on the destination computer.
On your destination computer, you can either use the same DAQ hardware
configuration as your source computer or you can access your source
computer’s DAQ hardware configuration remotely from the destination
computer. Refer to the Exporting a Task and Importing a Task sections for
more information about how to set up your computer one of these two
ways.

Exporting a Task
Complete the following steps to export a task to another computer.

1. Select a VI Logger task name in the MAX configuration tree.
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2. Click Export in the toolbar, or select Tools»VI Logger»Export 
Task, or right-click the VI Logger task and select Export. The
Save As dialog box appears.

3. Enter a task name followed by an .xml file extension.

4. Choose a location on your computer where you want to save the task.

5. Click Save. The .xml file is then saved to the specified location on
your computer.

Refer to the Importing a Task and Setting Up Your Destination Computer
for Remote Access sections for more information about accessing a device
and its hardware configuration remotely from a destination computer. If
your destination computer has an identical device and device hardware
configuration setup as your source computer, continue to the following
Importing a Task section.

Importing a Task
Complete the following steps to import a task into VI Logger.

1. From the menu, select Tools»VI Logger»Import Task.

2. Select the task .xml file you exported earlier. If you are remotely
accessing the device, select the .xml file from the source computer.

3. Click Save Task and then Run Task.

Setting Up Your Destination Computer for Remote Access
Complete the following steps to configure a destination computer for
remote access.

1. On your source computer, select Start»Programs»National
Instruments»NI-DAQ»Remote Device Access Server.

2. On destination computer in the MAX configuration tree, right-click
Devices and Interfaces and select Create New.

3. Select RDA/Ethernet device and click Next.

4. Enter the Remote Computer/IP Address of the source computer and
click Finish.

5. In the Remote Devices field, select the device that your task was
configured for on your source computer and click Next.

6. Define the local device number that you want to use. Only the available
device numbers appear.
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7. On the destination computer, select the task, and select the Task
Attributes tab.

8. Select the destination computer’s remote device number in the device
list.

The device shows under the Devices and Interfaces level of the MAX
configuration tree and the virtual channels for that device are copied into
Data Neighborhood.
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3
Controlling Your Task
Programmatically
Using LabVIEW

Although VI Logger is a stand-alone tool, you also can use LabVIEW to
control tasks programmatically, which gives you greater control over
executing tasks. This chapter explains background information about using
the LabVIEW VI Logger VIs. Refer to the VI Logger Help for more
information about specific VIs.

Before you start building a VI Logger application in LabVIEW, you should
know some of the following basic concepts about VI Logger in MAX:

• Configuring a VI Logger task in MAX

• Running a VI Logger task in MAX

• Viewing data from a VI Logger task run in MAX

Refer to Chapter 2, Creating and Running a VI Logger Task, for detailed
information about VI Logger tasks in MAX.

Executing a Task Using the VI Logger VIs
Use the VI Logger VIs located on the Functions»VI Logger palette to run
your task. The VI Logger palette contains Easy, Intermediate, and
Advanced VIs. Refer to the VI Logger Help for more detailed information
about specific VIs.
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The following figure of the LabVIEW VI palette shows the location of the
VI Logger VIs on the palette.

Using Easy VI Logger VIs
Use the Easy VI Logger VIs to perform high-level VI Logger operations.
With these VIs, you can begin executing a VI Logger task configured in
MAX, read live data from the task while it is logging, wait for the task to
finish, or manually stop a VI Logger task.

Using Intermediate VI Logger VIs
Use the VI Logger Status VI to obtain status information from the currently
executing task. The status contains information about the state of the task,
such as how many points have been logged and if a backlog exists. A
growing backlog indicates a lack of CPU bandwidth to log the data. You
can free CPU processor time by turning Event Detection off, not publishing
data to DataSocket, or not reading all the logged data in LabVIEW. You
can configure these options in MAX or programmatically using the
Logger Set Output VI.

1 Easy VIs 2 Intermediate VIs 3 Advanced VIs 4 Data VIs

1

2

3

4
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Using Advanced VIs
Use the Advanced VI Logger VIs to gain more control of VI Logger tasks.
Use the Advanced VIs to load a VI Logger task and have multiple start and
stop sequences before unloading the task. You can also reset a specific task,
which is useful if your previous execution aborted abnormally.

Executing a Task Using the VI Example Logger VIs
Refer to the Examples\VI Logger\Logging Examples.llb directory
for common solutions using the VI Logger Reader VIs. These examples
show you how to use the VI Logger Easy Reader VIs to view the logged
data of a task named My Task1.

Reading Historic Data Using the VI Logger Data VIs
Use the VI Logger Data VIs located on the Functions»VI Logger»VI
Logger Data to read and analyze logged historic data.

Use the VI Logger Data VIs to open, read, get attributes, and close the tasks
you created in MAX. The VI Logger Data palette contains Easy,
Intermediate, and Advanced VIs.

Using the Easy VI Logger Reader Data VI
Use the Easy VI Logger Reader VI to perform simple read operations. You
can run this VI from its front panel or use it as a subVI in basic reading
applications. The Easy VI Logger Reader VI outputs polymorphic data as
waveform data or as a 2D scaled data array.

Note All data has time stamps, so you can view it with its time information.

Using the Intermediate VI Logger Reader VIs
Use the Intermediate VI Logger Data VIs to provide more functionality for
complex historical data and analysis. From any logging task, you can view
any run and access its attributes.

Using the Advanced VI Logger Reader VIs
Use the Advanced VI Logger Data VIs to provide additional functionality
for complex historical data analysis, such as opening any logging task or
access any runs or a selected attribute.
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Using VI Logger Reader Example VIs
Refer to the Examples\VI Logger\Reading Examples.llb directory
for common solutions using the VI Logger Data VIs. The VI examples
show you how to use the VI Logger Easy Data VIs to view the logged data
of a task named My Task1.
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A
Math Expression Editor
Function Descriptions

This appendix describes the math expression editor functions in detail.
Complete the following steps to access these functions for use in a
calculated channel.

1. Click Add Channel from the from the Calculated Channels tab. The
the Math Expression Editor dialog box appears.

2. Select User Defined in the Formula field of the Formula Settings
section. You can use these functions in formulas for a calculated
channel.

Example

sin(Ch 1/Ch 2) + 3*tan(Ch 3)2-2

You can use the following operators:

+ and – for addition and subtraction

* and / for multiplication and division

** and ^ for exponentiation

Function Name Purpose

abs(x) Absolute Value Returns the absolute value of x

acos(x) Inverse Cosine Computes the inverse cosine of x in radians

acosh(x) Inverse Hyperbolic Cosine Computes the inverse hyperbolic cosine of x

asin(x) Inverse Sine Computes the inverse sine of x in radians

asignh(x) Inverse Hyperbolic Sine Computes the inverse hyperbolic sine of x in

atan(x) Inverse Tangent Computes the inverse tangent of x in radians

atanh(x) Inverse Hyperbolic Tangent Computes the inverse hyperbolic tangent of x
in degrees
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ceil(x) Round to +Infinity Rounds x to the next higher integer (smallest
integer is greater than or equal to x)

cos(x) Cosine Computes the cosine of x in radians

cosh(x) Hyperbolic Cosine Computes the hyperbolic cosine of x in
degrees

cot(x) Cotangent Computes the cotangent of x in radians
(1/tan(x))

csc(x) Cosecant Computes the cosecant of x in radians
(1/sin(x))

exp(x) Exponential Computes the value of e raised to the x power

expm1(x) Exponential (Arg-1) Computes the value of e raised to the x power
minus 1 (e^(x-1))

floor(x) Round to -Infinity Truncates x to the next lower integer (largest
integer is smaller than or equal to x)

getexp(x) Mantissa & Exponent Returns to exponent of x

getman(x) Mantissa & Exponent Returns to mantissa of x

int(x) Round to Nearest Round its argument to the nearest integer

intrz(x) Round Toward 0 Rounds x to the nearest integer between x
and 0

ln(x) Natural Logarithm Computes the natural logarithm of x (to the
base e)

lnp1(x) Natural Logarithm
(Arg + 1)

Computes the natural logarithm of (x + 1)

log(x) Logarithm Base 10 Computes the logarithm of x (to the base of 10)

log2(x) Logarithm Base 2 Computes the logarithm of x (to the base 2)

pow(x, y) x^y Computes the value of x raised to the y power

rand( ) Random Number (0-1) Produces a floating-point number between 0
and 1 exclusively

sec(x) Secant Computes the secant of x, where x is in radians
(1/cos(x))

Function Name Purpose
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sign(x) Sign Returns 1 if x is greater than 0, returns 0 if x is
equal to 0, and returns –1 if x is less than 0

sin(x) Sine Computes the sine of x, where x is in radians

sinc(x) Sinc Computes the sine of x divided by x radians
(sin(x)/x)

sinh(x) Hyperbolic Sine Computes the hyperbolic sine of x in degrees

Sqrt(x) Square Root Computes the square root of x

tan(x) Tangent Computes the tangent of x in radians

tanh(x) Hyperbolic Tangent Computes the hyperbolic tangent of x in
degrees

pi(1), pi(2) pi, 2pi —

Function Name Purpose
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B
Setting Up an Event E-mail

This appendix describes how to set up an event e-mail using the Event
Action feature in VI Logger. The event e-mail is sent when an event starts
and when it stops. VI Logger uses the SMTP Send Message VI from the
LabVIEW Internet toolkit to generate the e-mail.

Complete the following steps to set up an e-mail event action.

1. In either the Virtual Channels or the Calculated Channels tab,
Active Channel field, right-click a channel name for which you want
to set an event.

2. Select Events to open the Event properties for dialog box.

3. In the Event properties dialog box, in the Action Type field, select
Send Email Message.

4. In the Mail Server field, enter the SMTP server to send the message
through.

5. In the Message field, enter a custom message to include in the e-mail.
Your custom message appears first, and then the default message is
appended to your custom message.

6. In the To: field, enter a list of e-mail addresses to which to send the
event message.

7. Click OK.

This is what an example e-mail message may look like:

From: VI Logger

To: John Smith@ni.com

Subject: “My Temperature Channel 1” has exceeded its 

event limit.

testing

Thursday, March 15, 2001

8:34:29 AM

DAQ Channel: “My Temperature Channel 1”

Current value: 51.000000 C

Event Type: High

High Limit: 50.000000 C
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Values of all Channels:

My Temperature Channel 1: 51.000000 C

The appropriate values and strings that are entered into the e-mail message
are shown:

{Custom message here}

{Day of week, Month, Date, 4-digit year}

{HH:MM:SS AM/PM}

DAQ Channel: “{Channel Name}”

Current value: {Current Value} {Channel Units}

Event Type: {Event Type}

High Limit: {High Limit} {Channel Units} 

Low Limit: {Low Limit} {Channel Units}

Values of all Channels:

{First Channel Name}: {First Channel Value} {First 

Channel Units}

{Second Channel Name}: {Second Channel Value} {Second 

Channel Units}

...

{Last Channel Name}: {Last Channel Value} {Last Channel 

Units}
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C
Technical Support Resources

Web Support
National Instruments Web support is your first stop for help in solving
installation, configuration, and application problems and questions. Online
problem-solving and diagnostic resources include frequently asked
questions, knowledge bases, product-specific troubleshooting wizards,
manuals, drivers, software updates, and more. Web support is available
through the Technical Support section of ni.com.

NI Developer Zone
The NI Developer Zone at ni.com/zone is the essential resource for
building measurement and automation systems. At the NI Developer Zone,
you can easily access the latest example programs, system configurators,
tutorials, technical news, as well as a community of developers ready to
share their own techniques.

Customer Education
National Instruments provides a number of alternatives to satisfy your
training needs, from self-paced tutorials, videos, and interactive CDs to
instructor-led hands-on courses at locations around the world. Visit the
Customer Education section of ni.com for online course schedules,
syllabi, training centers, and class registration.

System Integration
If you have time constraints, limited in-house technical resources, or other
dilemmas, you may prefer to employ consulting or system integration
services. You can rely on the expertise available through our worldwide
network of Alliance Program members. To find out more about our
Alliance system integration solutions, visit the System Integration section
of ni.com.
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Worldwide Support
National Instruments has offices located around the world to help address
your support needs. You can access our branch office Web sites from the
Worldwide Offices section of ni.com. Branch office Web sites provide
up-to-date contact information, support phone numbers, e-mail addresses,
and current events.

If you have searched the technical support resources on our Web site and
still cannot find the answers you need, contact your local office or National
Instruments corporate. Phone numbers for our worldwide offices are listed
at the front of this manual.
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Glossary

D

DAQ See data acquisition.

data acquisition DAQ. Process of acquiring data, typically from A/D or digital input plug-in
devices.

L

LED Light-emitting diode.

M

MAX Measurement & Automation Explorer. See also Measurement &
Automation Explorer.

Measurement &
Automation Explorer

The standard National Instruments hardware configuration and diagnostic
environment for Windows.

N

noise An undesirable electrical signal—noise comes from external sources such
as the AC power line, motors, generators, transformers, fluorescent lights,
soldering irons, CRT displays, computers, electrical storms, welders, radio
transmitters, and internal sources such as semiconductors, resistors, and
capacitors. Noise corrupts signals you are trying to send or receive.

P

Plug and Play devices Devices that do not require DIP switches or jumpers to configure resources
on the devices. Also called switchless devices.
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S

scan rate The number of scans per second. For example, a scan rate of 10 Hz means
sampling each channel 10 times per second.

T

trigger Any event that causes or starts some form of data capture.

V

VI See virtual instrument (VI).

virtual instrument (VI) Program in LabVIEW that models the appearance and function of a
physical instrument.


	Getting Started with VI Logger
	Support
	Worldwide Technical Support and Product Information
	National Instruments Corporate Headquarters
	Worldwide Offices

	Important Information
	Warranty
	Copyright
	Trademarks
	WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS

	Contents
	About This Manual
	Conventions
	Related Documentation

	Chapter 1 Using VI Logger
	Overview
	VI Logger Features
	Using VI Logger VIs in LabVIEW

	Checking Your System Requirements
	Installing Your Hardware
	Installing Your VI Logger Software
	Configuring and Testing Your Hardware

	Chapter 2 Creating and Running a VI Logger Task
	Configuring, Modifying, and Testing Your�Measurement�Device
	Using an RDA Device with VI Logger
	Creating Virtual Channels
	Modifying Virtual Channels
	Testing Virtual Channels

	VI Logger Basics
	Creating and Configuring Your Task Using VI Logger
	Setting Up the Virtual Channels in Your Task to Acquire and Log Data
	Setting the Logging and Data Acquisition Conditions
	Using the Default Acquisition and Logging Settings for Your Task
	Using Conditional Acquisition for Your Task
	Using Conditional Logging for Your Task
	Using Channel Events for Logging
	Using Both Conditional Acquisition Triggers and Conditional Logging for Your Task

	Setting Up Network Publishing to View Your Data from Another�Computer
	Creating Calculated Channels

	Modifying Your Task
	Duplicating Your Task
	Deleting Your Task and Data
	Running Your Task
	Stopping Your Task
	Viewing Your Data
	Viewing Your Data Graphically
	Monitoring Your Acquired Data
	Viewing Your Logged Data
	Plotting Your Data
	Zooming In or Out on Your Data
	Modifying Your Plots or Display View
	Modifying the Legend
	Determining Time Difference, Frequency, and�Values�Using�Plot�Cursors

	Printing Your Data
	Exporting Your Data
	Setting Advanced Export and Programming Options
	Loading a User-Defined Export Template
	Loading an HTML Export Template
	Modifying the Template
	Variables
	Table 2-1. Global Variables
	Table 2-2. One Value Variables 
	Table 2-3. Index List Row Variables
	Table 2-4. One Channel Value in a Row Export Variables
	Table 2-5. Syntax Characters for Repeat Function
	Table 2-6. Special Syntax Characters for Repeat Function
	Export Template Examples


	Creating a New Database
	Compact a Database
	Rename a Database
	Delete a Database

	Exporting a Task to Another Computer
	Exporting a Task
	Importing a Task
	Setting Up Your Destination Computer for Remote Access


	Chapter 3 Controlling Your Task Programmatically Using LabVIEW
	Executing a Task Using the VI Logger VIs
	Using Easy VI Logger VIs
	Using Intermediate VI Logger VIs
	Using Advanced VIs
	Executing a Task Using the VI Example Logger VIs

	Reading Historic Data Using the VI Logger Data VIs
	Using the Easy VI Logger Reader Data VI
	Using the Intermediate VI Logger Reader VIs
	Using the Advanced VI Logger Reader VIs
	Using VI Logger Reader Example VIs


	Appendix A Math Expression Editor Function Descriptions
	Appendix B Setting Up an Event E-mail
	Appendix C Technical Support Resources
	Glossary
	D-P
	S-V


